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Dreamweaver Basics

Introduction

Adobe Dreamweaver CS4 is a web authoring software that aids in the creation and maintenance of
web pages. Dreamweaver uses tools similar to those found in a word processing program to allow
for the development of web pages without knowledge of HTML. It also provides the option of
hand-editing the HTML for greater control of the document.
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Opening Dreamweaver

To open Dreamweaver in the Training Room (2615 Crossroads), double-click the Dreamweaver
icon. Your home or office computer may not have a Dreamweaver icon. If that is the case, you
should find Adobe Dreamweaver in your Start Menu -> Programs.

Defining a Site

There are two parts to your website — your local files, and your remote files. You create local files
on your computer using Dreamweaver, and upload them to your remote web space via SFTP
(secure file transfer protocol). It is very important that the files on your local computer are set
up exactly the same as the files on your remote web server. That is, that they are all in the
same location relative to each other.

Before you can upload local files to a web server, you must create what Dreamweaver calls a Site
File. Site Files contain information about where your files are stored locally, where they are stored
remotely, and how they will be transferred back and forth between your computer and the web
server. You should do this before you create your first web page.

All UM students, faculty and staff have free website space available to them from ITCS. We will
utilize this space in today’s workshop. The URL of your personal website space is
http://www-personal.umich.edu/~youruniguename/.

All of your website files will be stored in the Public/html folder of your IFS space. Please see
http://www-personal.umich.edu/~pattyb/webspace.html for instructions on checking your web
space. If you do not have an html folder, please contact ITCS.

If you need to work on a web page on the SPH web server, | will help you set up your site file
definition.

To create a new Site File, click the Manage Sites link in your Files Panel.

" Files i=

5 Assets

I:ﬁ Deskkop _'J Manage Sites ——————— arﬁage Sites
1

B :éj Desktop

[ g, My Computer

The Manage Sites dialogue window will come up. Click New. The Site Definition wizard will come
up:
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Site Setup for Unnamed Site 2 L]

Site

Servers

Version Control

» Advanced Settings

A Dreamweaver site is a collection of all of the files and assets you use in your
website. A Dreamweaver site usually has two parts: a local folder on your
computer where you store and work on files, and a remote folder on a server
where you post the same files to the web.

Here you'll select the local folder and a name for your Dreamweaver site,

Site Name: | Unnamed Site 2 |

Local Site Folder: | C:\Users\pattyb\Documents'htdocs\Unnamed Site 2\ | B

[ save ][ conce |

Site

Site Name: Give your site a desired name. Type in a name that provides a meaningful

description of your site.

Local Site Folder: This is where you will store the local copies of your files. Click the folder
icon and navigate to your personal space. Create a folder there for your project and select it.

SPH Web Services
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Click Servers in the left-hand column.

Site Setup for Unnamed Site

Site
Servers

Here you'll select the server that will host your pages on the web. The settings
for this dialog box come from your Internet Service Provider (ISP) or your web
Version Control administrator.

» Advanced Settings
9 Note: You do not need to complete this step to begin working on your Dreamweaver site. You

only need to define a remote serverwhen you want to connect to the web and post your
pages.

Name | Address | Connection | Remote | Testing |

[_swve || concd |

Click the plus sign (+) to add a new server.

This next set of questions refer to the remote web server you are using. This will be the ITS
web server:

Server name: does not matter

Connect using SFTP

SFTP address of your web server is sftp.itd.umich.edu

Username is your UM unigname

Password is your Kerberos password

Root director: Public/html/
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[ Basic | Advanced |

Server Name: | Remote Server I

Connect using: | SFTP

SFTP Address: | sftp.itd.umich.edu | Port:

Username: I unigname |

Password: | sesssees | M save

Test

Root Directory: | Public/html/ ]

Web URL: [ http://www-personal.umich.edufunigname/ |

| Save I | Cancel ]

Click the Test button. If you have entered all of the information in successfully, you will see

a message saying that you have connected successfully. Click OK and then Next.

SPH Web Services
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Site Definition for mySite
Basic | Advanced |

Site Definition

Editing Files Testing Files Sharing Files, Part 2

Do you want to enable checking in and checking out files, to ensure that you and your co-workers
cannot edit the same file at the same time?

" Yes, enable check in and check out.
* No, do not enable check in and check out.

< Back Next > Cancel Help

x|

Do you want to enable checking in and checking out files? Only say yes to this

guestion if you will not be the only person updating this website. Enabling checking in and
checking out makes it so that only one person can edit a single file at the same time. Click

Next.
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Site Definition for mySite REI x|
Basic | Advanced |

Site Definition ) ,

- -

Your site has the following settings:

Local info: {Local root folder will be created)
Site Name: mySite
Local Root Folder: C:\Documents and Settings\pattyb\iMy DocumentsimySite’s

Remote info:
Access: FTP
FTP Host: ftp.ifs.umich.edu
Check-in/check-out: Disabled.

Testing server:
Access: I'll set this up later.

Your site can be further configured using the Advanced T ab.

< Back Done Cancel Help

You will see a summary of your Site Files definition. If everything looks good, click Done.

You can modify your Site Files definition at any time by going to Manage Sites in the Files Panel.
This will bring up the Site Definition dialogue box, where you can make the desired changes. You
can also have as many different Site Files as needed.
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The Dreamweaver Work Area

2% m- o &~ | esioner v | [P | =
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Document Window
The Document Window is your work area where you create and edit your web page.

Dreamweaver has the option to display the Document Window in three different ways: the code
view, the design view, and the code and design view. The code view shows HTML only. The
design view shows only the design, or the visual layout of your page. The code and design view
shows a combination of the two.
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To toggle between the different views, go to View = and select Code, Design, or Code and
Design. You can also use the shortcut icons located at the upper left of your screen.

(2| Code | <3} spit | || Desion |—  ign
|

Code

ISR ~sex | Insert Panel
D The Insert Panel allows you to insert web objects into your web
. «|| pages, such as images, forms and media. Each Group (such as
W Hypernk “common” listed here) contains a group of specific objects. The
(=9 Emal Unk Common group has everything you will need today.
& Named Anchore
F7l Table
Insert Div Tag
@- Images
@)~ Medo 1
@ Date
£ Server-Side Inchude
() Comment ~|
! ¥ Files i Files Panel

['Fies WS The Files Panel is more than a file browser. It allows you to see the

- structure of all the files and directories in your website. You can
] Desktop | Manage stes open, move, copy, rename and delete files from the Files Panel. We
= /4] Desktop will talk more about your Site Files later in the workshop.

& % My Computer

Properties Panel
The Properties Panel provides details of the properties of a selected object. The Properties Panel
will change depending on the object or text that is selected.

aaotieyy - |
< rem rone Fre o] O [nore - w7 e e
hos © [vore o Jdoo reml I

[ Page Pvspernas | )
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Tag Selector

The Tag Selector is located in the bottom left corner of the screen. It shows the HTML Tags that
correspond to the area where your cursor is placed in the Document Window. Selecting a tag in
the Tag Selector it will select the corresponding area in the Document Window.

|<body> <table> <tr> <td>/<a><ima> len the

ze that is

Document Toolbar
The Toolbar allows you to toggle between views, and shows the title of the document. It also has
shortcut icons that allow you to upload and download your file, and preview the page in a browser.

2 Code|:|;]5p& | |3 Design | Tite: | Untitled Document fod 1 & =),

' |
>cument Title |

vser

Other Panels

There are several additional panels on the left side of the work area, including Design,
Code, Application, and Tag Inspector. These panels are designed to provide additional
information about Web Development. For example, the Code Panel allows you to look up
HTML tags, CSS syntax, Javascript syntax, and much more. We will not cover these panels
during this workshop.

Working with Panels
Occasionally, a panel will become “detached” from the workspace and become a “floating”
window. This can be annoying because the panel is always on top, blocking your view of
the page. To re-attach a panel, click the Designer button at the top of the window, and
choose Reset:

|[EsieneR 7] | (2
E App Developer
App Developer Plus

Classic

— Coder
Coder Plus v] lLocaI view

v Designer l & Y a4 8 | =
Designer Compact

Dual Screen ittyb\Documents\htdocs...

-

Reset 'Designer’ s
New Workspace...

Manage Workspaces...

g .
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Moditfying Page Properties

When you modify the Page Properties by clicking the Page Properties Button in the Properties
Panel (or going to Modify = Page Properties), you make global settings to your document.

Page Properties X

Category Appearance (CSS)
R Page font: ~] B| z|
Links (CSS) :
t;e:?;mogcr?gs) Size: | [ =]
RlefEnc
Tracing Image Text color: _[__!”

Background color: E!“

Background image: | Browse... |

Repesti [ 1]

wtmogn: [ [ =] Rowmson:[ [ =]
Top margin: I_l-_;I Bottom margin: [_ II_L-]

Hep | oK concel | appty |

On the left side of the Page Properties window are several categories of page properties. The first
one is Appearance (CSS). Here you can choose the default font-family, font size, font color,
background color, background image and all four margins for your document. You can still use
different fonts and colors in different parts of your web page. This just sets the default settings for
the entire page.

Font Families

You will notice that when you click the carrot for page font, there are not many fonts on the list.
This is because the font you choose will only display in the user's browser if the user has that font
installed on their machine. You may also notice that each item in the list contains more than one
font, for example, "Arial, Helvetica, sans-serif." Sans serif is what is known as a font family, as are
serif, fantasy, script and monospace. By choosing "Arial, Helvetica, sans-serif,” you are saying "If
the user has Arial installed, display my text in Arial. If they don't have Arial, but they have
Helvetica, display my text in Helvetica. If they don't have Arial or Helvetica, display my text in
whatever sans-serif font they have chosen as their default.
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Font Sizes

It is important to choose a measurement of font size that allows users to increase or decrease the
size of text on your page, or a relational font size. This is especially true for users with vision
disabilities who need the text to be bigger in order to read it. While pixels is designed to relational,
it is not treated as such by Internet Explorer. Try using 1 em instead of 12 pixels, or .8em instead
of 10 pixels.

Colors

It is important to use highly-contrasting foreground and background colors. For example, if you use
a dark background, choose a light text color. Also, even if you want a white background and black
text, you should select these, as gray is the default background color for the Netscape browser.

All computer monitors can display 216 colors called the Browser Safe Colors. Browser Safe
Colors are defined by a hex (six-character) code containing 00, 33, 66, 99, CC, or FF. An example
of a Browser Safe hex code is 33CCFF. Dreamweaver allows you to choose from the 216
available Browser Safe Colors by using the color picker:

[ ] =z 2O

LLLEEER Y

You can click the color wheel at the top of the color picker to find additional colors.
Background Images
Please note that background images tile on a web page. That means that they display over and

over in rows and columns. If you use a background image, make sure that it is a small (usually
around 100 pixels by 100 pixels) and will blend well when tiled.
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Links (CSS)

The next thing you will define is the Links category.

x

Category Links (CSS)
Appearance (CSS)

ﬁ&ﬁeiHT&i i B Same &5 p :l ll_il
?:1:%?: ofgs) Size: | ~| [ =]
Tracing mage tnkcolor: ([~ Roboveriks: ([

Underline style: [always underiine =

Help | oK Cancel Apply

Here you can change the font face, size and color of the four link states:

Linked color: the color of linked text

Visited links: the color of links to pages that the user has already visited
Rollover links: the color of links while the user is rolling their mouse over them
Active links: the color of links while they are being clicked on

You can also select an Underline style. The default is that links are always underlined, which
users expect, but you can change it so that links are never underlined, are only underlined
during mouse rollover, or are underlined except during mouse rollover.

It is perfectly acceptable to leave these all on their defaults (which is blue underlined text for
links and purple underlined text for visited links) but feel free to play around with these settings.
What is most important is that your visited link color is different from your regular link color. This
is a visual clue to users that they have already visited a page.
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Headings

The final category of Page Properties that you should set are Headings (CSS).

Page Properties
Category Headings
Eﬂf‘:mm | Heading font: | Times New Roman, Times, serif v|B| 1
' Heading 1: | 1.3 viems | [
Tracing Image Hesdg2: [12 3 ‘ = "’l E-J
stz (i1 Wlew ¥ G|
Heading 4: o | pixek [
e [
Heading6: | v pie i

[ ok || cancel || appy || Hep |

Headings are used for page titles, section titles, sub-section titles, and so on. They are used to
structure your web page. HTML offers six levels of headings, with Heading 1 being the largest and
Heading 6 being the smallest. | rarely use more than three levels of headings to structure web
pages.

In the image above | have set the heading font, specified that all headings should be bold, and set
the font sizes for headings one through three. Note that | again used the em measurement of font
size so that users can increase and decrease the size of the text.

Once your selections have been made, press Apply to apply the settings to the page and OK to
accept the changes.
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Page Titles for the Title Bar

The last global page property that you will set is the page title for the title bar. The title bar is the
blue space at the very top of every browser window, as circled in the below image:

‘2 University of Michigan School of Public Health - Microsoft Interne... Q@@

File Edit View Favorites Tools Help i l'f
- A 7 A _ - ) »
_ W < lﬂ @ | S Search e Favorites {} 0~
. Address @ http:/fwww.sph.umich.eduf v Go @~

~
Departments ar

m SPH University of Michigan Sc

SEARCH BBl :
bout UM SPH fVelcome \a repire il ~ i
About 7 \ W
Admiccinne & Sthivlante y @ N
< >

g] ® Internet

Enter the text that you want to appear in the title bar in the Dreamweaver title box:

' 42| Code I*;,_’;-' Spbt[ i, Desigrj_ Title: :Untitled Document _
';"Glllllllllrslolllllllllllolull|llll lislolllllll zloloulun lelc:1llllll3;010|lllllll3|slc
03
=
0 3
e
03
&

Whatever you enter there will appear in the web browser's title bar. Use short but descriptive page
titles.
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Formatting Text

You can modify individual sections of text by using the Properties Panel. First select the text you
would like to change and then make the necessary changes by using the options available to you
in the Properties Panel. Using the available tools, you can:

Create headings and paragraphs
Change the face and size of the font
Change the color of the text

Create bold, or italic text

Adjust alignment to right, center, or left
Indent text

Create bulleted or numbered lists

Format Bold/Italic 1t
v | | =
Format [None =] style [one ~| Blz| E|E2|E|E| uk] o =) %
Font | Default Font v Size | None +|| =] L_zl IS= | gl I&Qetl '|
(Pade Propefties... ) (_ Lst e, |
s
| | |
Font Type

nbered List

Formatting Headings and Paragraphs

The first thing you want to put on your web page is the page title. Put your cursor in the document
window and type in the page title. Next click the drop-down for the Format property in the
Properties Panel. Here you see your choices: paragraph format, any of the six levels of headings,
and Preformatted. Since the level 1 heading is the highest level, it should be used for page titles.
Choose Heading 1 in the Format drop-down list:
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To go to the next line, put your cursor at the end of your page title and click the Enter (or Return)
button on your keyboard. Type in your first paragraph. Notice that the value of the Format property
in the Properties Panel now says Paragraph. This is because Dreamweaver is smart enough to
know that you wouldn't want two level-1 headings in a row.

You might also notice that there is a blank line between your page title and your first paragraph.
Any time you hit the Enter (or Return) button on your keyboard, you will skip down a line. This is
because in HTML (the language web pages are written in) there is always a blank space between
block-level objects on a page, such as headings and paragraphs. If you want a line break instead
of a paragraph break, hold down the Shift key while hitting Enter (or Return).

You can select any words in your paragraph and change their font-face, font-size, color, and
make them bold or italic by changing those properties in the Properties Panel. You can change
the alignment of headings or paragraphs by clicking any of the alignment icons in the Properties
panel.

Lists

There are two types of lists on web pages: Ordered (or numbered) and Unordered (or bulleted).
To create a list, put your cursor just above where you want the list to be and hit Enter (or Return) to
start a new paragraph. For an ordered list, click the Ordered List icon in the Properties Panel. For
an umordered list, click the Unordered List icon in the Properties Panel.

Type your first list item, and then hit Enter (or Return) to go the next line. Your list will continue.
When you are finished with your list, hit Enter and click the Ordered or Unordered List icon again to
turn it off (or just hit Enter twice).

Nested Lists

Let's say you want an unordered (bulleted) list nested inside an ordered (numbered) list as a sub-
list. Type in your ordered list, then put your cursor at the end of the line just above where you want
your sub-list to start. Hit the Enter (or Return) button on your keyboard, then click the Indent Icon
in the Properties Panel. Next, click the Unordered List icon in the Properties Panel to change the
nested list to an unordered list. Type in your unordered list. When you want to return to your
ordered list, hit Enter (or Return) and click the Ordered List icon in the Properties panel to resume
your ordered list. Here is an example:

1. First ttem in ordered list
2. Second ttem in ordered list

o First ttem in nested unordered list

o Second item in nested unordered list
3. Third ttem 1n ordered ].isﬂ
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Using Text from Microsoft Word

We frequently need to copy text from Microsoft Word and paste it into Dreamweaver.
Unfortunately, doing so causes many problems. Huge amounts of junk code that can
quadruple the file size, and can only be displayed by Internet Explorer, get copied and
pasted along with the text. The worst offenders are “auto correct while you type” characters
such as curly quotes and emdashes.

Text should never be copied from Word and directly pasted into Dreamweaver. Fortunately,
Dreamweaver gives us two alternatives:

1. Import a Word Document

Edit View Insert Modify Format Commands Site

L e ﬁ
" New CSS Sculptor Page...

! Open.. Ctrl+0 mobile.css  header.inc 1
Browse in Bridge... Ctrl+Al+0 \ fLive Code | Tide:
:  OpenRecent » e e———
L OpeninFrame... Ctri+shift+0  jEEyanisand Honors > Alum
Close Chrl+W
£ Close al Clr-Shift+W
Share My Screen... ent of Epidemiolog)
Save CErl+5
Save As... Ctrl4Shift+5 i Honors
Save All
Save to Remote Server...
Save as Template...
Revert 4 - ~
idemiology Section
__ Print Code... Curk+P Btchins, was selected as t
Export »  Tabular Data...
Convert » Word Document...

— Excel Document...
Preview in Browser ert, M.S., was one ofthe F
Ch.eckPage AiCouncil on Academic F

¢ Validate

«  Compare with Remote
Design Notes...

1] Exit CtrH-Q

If you want to place the entire contents of a Word file into your web page, please
your cursor where you want the text to go on the page and click the File drop-down
menu and choose Import -> Word Document. You will be prompted to navigate to
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the Word file you want to import. Dreamweaver will insert the contents of the
document at the place of your cursor.

2. Clean Up Word HTML

If you don’t want to insert the contents of an entire Word document into your page, you
can copy and paste just the text you want from Word, use the Clean Up Word HTML
command to get rid of the junk code that came with it. Just copy and paste and save the
file. Then click the Commands drop-down menu and choose Clean Up Word HTML.

Clean Up Word HTML i

Basic | Detaled |

Clean up HTML From |l Paaale

¥ Remove all word specific markup
W Clean up c55

W clean up <font> tags

V Fix invalidly nested tags

v Apply source formatting

ol
x

M show log on completion

It's fine to leave the default settings intact and click OK button to run the command.

3. Run the text through NotePad or WordPad first. A third alternative is simply to
paste the text copied from Word into either NotePad or Wordpad, then copy it from
there and paste it into Dreamweaver. You will lose some formatting, but all of the

nasty Word code will be gone.
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Saving Pages

To save the web page you are working on, click the File drop-down menu and choose Save.
Please note the following file naming conventions for the World Wide Web:

All web page files must end with the extension .htm or .html.

Your default homepage must be named index.htm or index.html.

Use all lower-case letters and numbers in your file and folder names.

Do not use spaces.

Do not use special characters like &, %, etc. Underscores (_), dashes(-) and
periods(.) are OK.

ahwWNPE

If you are saving your work to your personal space on the UM web server, you may notice that you
already have a file in your file list called index.html. It is fine to over-write this file. You cannot have
two index files in your html folder, one named index.htm and the other named index.html. You
should have only one default home page file.

Once you have your page properties and formatting set, an easy way to create secondary pages is
to click the File drop-down menu and choose Save As... Give the page a new file name and edit
its content appropriately.
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Adding Links

To add a link to another web page, first place your cursor where you
want the link to appear. Next, click the Link icon on Common Insert
Panel.

{7

B&E'E’g\liﬂﬂyg
!

The Hyperlink dialogue box will open. Here you will need to type in the

e text that you want to be clickable in the Text field

e the full URL of the webpage you want to link to in the Link field

e the Target field allows you to have the link open in a new window by choosing “_blank.” If
you do not want the link to open in a new window, leave the Target field blank.

e Textthat describes the link into the Title field (this can be the same as the text you want to
be clickable)

e You may leave the Tab Index and Access Key fields blank.

g\i
x

R =

Help
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But what if you want to make text that you have already typed link to another webpage? First select
the text you would like activated as a link. Once the text is selected, type in the full URL (e.g.
http://www.sph.umich.edu) in the Link field and the title into the Title_Field in the Properties Panel.

PROPERTIES

| <> HTML | Format |None
B Css 1D [None = ek ) i @ip o | 7|

If you need to link to another page in your site, you caf click the folder icon next to the link field and
navigate to that file. You can also click the Point to’File icon and drag it to the page you want to link to
in the Files Panel.
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Adding Email Links

Email Links are special links that you can use to make e-mail

e .|| addresses on your webpage clickable. If your user has an email client
etk installed on their computer, when they click an email link, their email
- ‘ client will open a new message addressed to the email address you
gl have specified.
= Horizontal Rule
] Table To add an email link, first place your cursor where you want the link to
Insert Div Tag appear. Next, click the Email Link icon on Common Insert Panel.
@. Images
&1~ Media ]
[ Date
1 Server-Side Include
() comment ~|

The Email Link dialogue box will open. Type in the text that you want to be clickable, and the e-
mail address, and click OK.

Note: Email links are often harvested by robots that search the web, collecting email addresses for
spammers.

Adding Anchors

Anchors are links that jJump to a specified location within the same page.
Creating an Anchor is a two-step process. First, you must indicate where
you want the link to jump to in the page (name the anchor). Then you
have to create a link to that location (link to the named anchor).

Creating a Named Anchor

7 To create a Named Anchor, place the cursor in the Document Window in
Insert Div Tag the location you would like your link to jump to. Then click on the Named
(2] tineges Anchor icon.

@~ Media |
f5 Date

1 server-Side Include

() comment |
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After clicking on the Named Anchor icon, an Insert Named Anchor dialog box will appear. Type
a short one-word name for the anchor in this. Press OK. The anchor has been named and you
can now link to the anchor.

Anchor name: | about

Pl

Linking to a Named Anchor

In the Document window, select the text you would like activated as a link. In the Link Field of the
Properties Panel, type the number sign (#) followed by the name of your anchor (e.g. type #top in
the Link field if you named your anchor top).

" v Properties
Fotrnat[None =] SthINone | CSSl B|II!|!|!E.] Li'kl#about eo
Font [Defauk Fort ¥ Sie 2 | I = B R

| Page Properties... | | ListItem... |
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Inserting Images

Ssssaaaeammensl nsert S| To insert images into your web page, place the cursor in the Document
Common ¥ window in the location you would like the image inserted. Next, click on

W Hyperink ={| the Insert Image icon in Common Insert Panel. This will open a

(=7 Email Link dialogue box that will allow you search for the file where the image is

& Named Anchor located. Browse to the desired image file and press Select. This will
&5 Horizontal Rule insert the image into the Document Wincdow.

FFl Table

Insert Div Tog Important Things to Remember about Using Images

@- Images

&~ Meds It is against U.S. copyright law to take images from someone else's
A || web page and display them on your own pages without permission.

) Severide Incuc Always make sure that your images are small — both in dimensions and
Q) Comnent =l| in file size. The smaller the file, the faster it will download and be

displayed on your page. | try to keep my images under 100k.

Always make your images the size you want them to display before inserting them into your page.
Don't insert them and then resize them.

Always supply alternate text for your images using the Alt field in the properties panel. This helps
users with vision disabilities who can't see your images understand what your images are about.
Use short, descriptive words for your alternative text.

Formatting Images

Once inserted, you can use the tools available to you in the Properties Panel to resize and align
the image (left, center, right), make the image into a link, or place a border around your image.

You may notice that images you insert into your page are contained in their own paragraph. There
are two ways to make other content — like text — wrap around your images. One is with tables, and
the other is with alignment, as shown in the following image:
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|[s2] Code |~*__j spit | (1] Design | Title: [Untitled Document T2 8. @ | C (B &
0 -100 |150 IZOB IZSU I3UO |350 |400 [4750 E: 00 |550
|

Here 1s a picture of Cali the Calico Cat. Here 1s
a picture of Cali the Calico Cat. Here is a
. picture of Cali the Calico Cat. Here 1s a picture
of Cali the Calico Cat. Here 15 a picture of Cali
the Calico Cat. Here 1s a picture of Cali the
Calico Cat. Here 1s a picture of Cali the Calico
Cat. Here 1s a picture of Cali the Calico Cat.
Here 1s a picture of Cali the Calico Cat. Here 1s
a picture of Cali the Calico Cat. Hereis a
picture of Cali the Calico Cat. Here 15 a picture
of Cali the Calico Cat. Here 1s a picture of Cali
the Calico Cat. Here 15 a picture of Cali the
Calico Cat. Here 1s a picture of Cali the Calico Cat. Here 1s a picture of Cali the Calico Cat.
Here 1s a picture of Cali the Calico Cat. Here is a picture of Cali the Calico Cat. Here is a
picture of Cali the Calico Cat. Here 1s a picture of Cali the Calico Cat.

LLLLI3 333001113383 8388383:3238 3388318388388 8333338888880 0RuRt1inQR;: 3

sody > [<ima>| (R Q [100% +|599x311v 2|<.t1‘.=.«.1:VJ

v Properties - i

m Image, 35K w257 |7 src [calicat.ipg 90 A |caica vl o«
| nisz | k| 00 @ @INEBO A

Mapﬁ VSpaceE Target Bmderﬁ EE =

R OO Hspace [10 | Lowsrc | & O Chign |Left D

P Results

Changing the value of the Align field to Left will make text wrap around your image on the right.
Similarly, changing the value of the Align field to Right will make text wrap around your image on
the left.
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Inserting Tables

S R : =| Toinsert a table into your web page, place the cursor in Document
Common ¥ Window the location you would like the table inserted. Next, click on

N\ Hyperink = the Insert Table icon in Common Insert Panel.
& Named Anchor
7] Table
Insert Div Tag
(2]~ 1mages
&1~ Media L
Date
gj Server-Side Include
@ Comment :]
x|
Table size
Rows: |1 Columns: |1
Table width: |80 Ipercer\t ZI :Iogue
Border thickness: IU pixels
Cell padding: [0 (5]
Cell spacing: [0
== | - - - ---
e [ g o oo | -
‘-:r— =EE ‘-r_l_
mrere | o o o -
Left Top Both
Accessibility
Caption: |
Align caption: |deFauIt 'I
Summary: | :l

Hep | ok | cancel |

The Insert Table dialogue window allows you to control all aspects of your table: how many rows
and columns it has, how wide it is, whether or not it has a border, and if it does, how thick that
border is, how much space there is between cells (cellspacing), how much space there is between
a cell’s content and the edge of the cell (cellpadding), header rows and/or columns, and more. Text
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inside header rows and columns is automatically bolded and centered. Have text appear above
your table by entering a Caption.

Once the desired format has been specified in the Insert Table dialogue box, press OK. The table
will now be inserted into your Web page in the Document Window. You will then be able to place
your cursor in each cell to add text or images.

Once you insert your table, you can make additional changes to the table’s format by selecting the
table and using the Properties Panel to make change the number of rows and columns, the
amount of cell padding and cell spacing, the alignment and width of your table, and the size of the
table’s border.

 Properties ";_='
:j Table Id Rows |4 w[544 [piels v| Cellead |0 flign [Defaut ] Class [ None @]
| "[ Cols |2 H ||Jl'xels "I Celispace |0 Border | O
glﬂﬂ Bgcdor_[_J'  Brdr calor _l_J[ '
IE’J i'_“] Zd Bg Image ' &0 .
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Laying Out a Page

Using Dreamweaver's Sample Layouts

Dreamweaver comes with built in sample page designs that you can use to set up your pages. Go
to File -> New you will see a list of these sample page layouts:

X
Page Type: Layout:
=% HTML <none> =1
Ls Blank Page = HTML template 1 column elastic, centered ST AX
- Library item 1 column elastic, centered, header and
\_3 Blank Template == ¥SLT (Entire page) 1 column fixed, centered
=y XSLT (Fragment) 1 colurmn fixed, centered, header and F em
= . ; 1 column liquid, centered
g Page from Template | == zgt;DnScnpt 1 column liquid, centered, headsr and f ﬂQl— 0000
. =y Javascript 2 column elastic, left sidebar
& Page from Sample = xML  cohnn elastic, Ieft: sidebar, header: o1
. 2 column elastic, right sidebar
. ) 2 column elastic, right sidebar, header .
, Other [ Ao Javana 2 column fixed, left sidebar o
u: ASP VBScript 2 column Fixed, left sidebar, header arn T‘-Mo mlms‘ o u_uldths nee (sothey scale
S ASP.NET C# HE =neh with font size), with left sidebar, header and
] 2 column fixed, right sidebar footer.
To) ASP.NETVB 2 column fixed, right sidebar, header ai—
T ColdFusion 2 column hybrid, left sidebar
'-_ ColdFusion component 2 column hybrid, left sidebar, header a1 DocType: IXHTM. 1.0 Transitional :J
T P 2 column hybrid, right sidebar
=) PHP 2 column hybrid, right sidebar, header . 1Ak e |Add to Head j
- 2 column liquid, left sidebar attach €55 file: e
2 column liquid, left sidebar, header an
2 column liquid, right sidebar _lll ’
<| | »
Help I Preferences... | Get more content... Create Cancel I

You can use any of these sample designs to create your own web pages. Just replace the sample
text with your own text, and add images.

Using a Consistent Page Design for Multiple Pages

Once you have gotten your first page formatted the way you like it, you can use it as a
template for other pages in your web site. After saving the file, click the File drop-down menu
and choose Save As... and save it with a new file name. Now you have a new file and a new
page. Change the content appropriately. Remember to save the page title for the title bar as
well.
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Previewing Your Site

It is important to preview your site in several browsers before you post your site in order to ensure
the content will be displayed appropriately. You can preview your document at any time, but keep
in mind that links will not be active until the site is previewed or posted to a server.

To preview your document, you must first select a browser. To do so, click the Preview/Debug
Icon in Browser icon in the File Toolbar and choose to Edit Browser List.

42| Code |ﬁ Split dDesign‘ Title: | Untitled Document g 40 &. | & [EL

wser Icon

Preferences X|

Category Preview in Browser
General

Accessibility _ = :
Code Coloring Browsers: ll _I Edi... I
Code Format
Egg: g:ﬁ“hg mozilla.exe F12

CSS Styles NETSCAPE 6.22 CulF12
File Types / Editors

Fonts

Highlighting

Invisible Elements Defaults: [V Primary Browser
Layers

iout View I~ Secondary Browser
# Document
1els

Preview in Browser

iexplore

cw

Options: |~ Preview Using Temporary File

Quick Tag Editor Checking this option will create a temporary copy

Site for preview and server debugging. To update the

?Tﬁ: Bar document directly please uncheck this option.
aldator
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After the browser has been selected or changed, you can preview the site by clicking the
Preview/Debug Icon in the File Toolbar. You can also press the F12 key on your keyboard to
display the current document in the primary browser.

Uploading Files

Once your site has been defined, you can publish your site. This means you can transfer your files
to a server so others may have access to your web site through the Internet.

Your Files Panel is always visible on the left side of the Dreamweaver work area. You can see
both your local and remote files at any time by clicking the Expand/Collapse button at the top of the
Files Panel.

[ Files
|uﬁ mySite ﬂ ILocaI view :]
Relndwalm

) Site - mySite (C:\Documents and fl

Clicking the Expand/Collapse button will open a Site Window with two panes, one for the Local
Folder and one for the Remote Site.

Local Folder
The Local Folder appears on the right-hand side of the window and contains a list of the files
stored on your computer or network.

Remote Site
The Remote Site appears on the left-hand side of the window and shows a list of the files stored on
the server. Until you connect to the server, the Remote Site side of the window will remain blank.
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To connect to the server and view the Remote Site, click the Connect button in the Site Files

toolbar.

[ Files
|E}; mySite j |Local view ;I
ReC|d OGN a|D

O ste -Tsn(c:mocunents and |

Once you have connected to the server, you can transfer files from the Local Folder to the Remote
Site and vice versa. You can do this by dragging selected files from one pane to the other, or by

using the Get File(s) and Put File(s) buttons in the toolbar.

When you transfer files to the server, you will be asked if you want to Include Dependent Files.
Including Dependent Files means that all the files dependent on the file you are transferring

(images, external style sheets) will also be transferred to the server.

Keep in mind that when you transfer files, you overwrite the existing file. Make sure you do not

copy over the most recent version, or the edits will be lost.
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Viewing Your Published Site

To view your published site, open a web browser and go to
http://www-personal.umich.edu/~youruniquename/filename.html.
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